
Virtual TimeClock Pro® Setup Guide


This guide will orient you to Virtual TimeClock and walk you through the essential setup required for a 
new user of Virtual TimeClock Pro. For installation follow the steps on our installation guide. If you are 
moving your TimeClock  or upgrading your software, review the moving guide or the upgrading guide.


Topics discussed in this Setup Guide:


A. Creating Company Database
1. After successful installation of the software, the Welcome window will automatically launch. You 

can either register for a Free Trial license or choose Enter Key to register your existing license.
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2. After registering for your free trial, you can 

choose to open Sample Data to explore the 
software with pre-populated users or open your 
new My Company database to add your users. 
If you registered an existing license, choose an 
option to open your company database.


3. After creating a new company, you will be 
prompted to add users. Users can be added 
manually or imported from a .csv or QuickBooks 
.IIF file. If you choose to add users manually, 
follow the steps below.


B. Add Users
1. If you want to add employees as users now, click Add Users. After entering a user’s information 

click Save & Next to continue adding users or Save & Close to finish adding users. 

2. After adding users you will be brought to the Configure Users window. To edit a user’s 

information, select the user name in the left column and use the Access, Employment and Notes 
tabs. For information, review the Overview of Users, Managers & Administrators article.


• In the Access tab you can set passwords and change a user’s status.


• The Employment tab contains information such as hire dates, wages, and more.


• The Notes tab allows you to input and record any other user information. 


3. To add more users, click Add in the bottom-left corner of the Configure Users window. To return 
to this window in the future, click Users from the Configure menu. 
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Caution: Deleting a user 
permanently removes the 
user and all their timecard 
information from the 
program. Instead of 
deleting, consider making a 
user inactive.


Use the popupmenu at the 
top of the User list to filter 
which users are displayed.

https://www.redcort.com/files/pdfs/payroll-guides/QuickBooks-Payroll-Integration-Guide.pdf
https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/overview-of-users-managers-administrators
https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/deleting-and-inactivating-users
https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/deleting-and-inactivating-users
http://www.redcort.com
https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/deleting-and-inactivating-users
https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/deleting-and-inactivating-users


D. Display Groups
To continue with setup, click the Groups icon in the toolbar of the Configure Users window to edit 
Display Group settings. Display Groups are how rules are assigned to specific groups of users. In short, 
these settings affect the display and options of the TimeClock for users. This is also where manager 
permissions are set, giving them access to reports and administrative functions. TimeClock Users is the 
default group and includes all users.


Below are examples of the different interfaces available in Virtual TimeClock
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1. With the Settings tab selected, 
choose the group interface users will 
clock in on. 


2. Choose between the In/Out Board, 
with the list of names, PIN, with 
numeric passwords or passcode.


3. Decide if users will use a password. 

4. If using the In/Out Board, users will 

be prompted to create a password 
the first time they clock in. Otherwise 
passwords need to be assigned to 
users in the Configure Users 
window.


5. Review the default settings by going 
though each of the tabs in this 
window and orient yourself to the 
settings of Virtual TimeClock. We 
recommend that after you familiarize 
yourself with the program to revisit 
these settings.

In & Out Board Interface


PIN Interface


https://www.redcort.com/virtual-timeclock-knowledge-base/features/display-groups/overview-of-display-groups
https://www.redcort.com/virtual-timeclock-knowledge-base/features/display-groups/time-clock-interface-options
https://www.redcort.com/virtual-timeclock-knowledge-base/features/display-groups/time-clock-interface-options
http://www.redcort.com


E. Important Notes for Display Groups
• To save time and for anonymity, many companies use the PIN or Passcode interface for 

employees to quickly login without seeing other users. The In/Out Board can be customized for 
privacy by unchecking Time and Elapsed, so users do not see the time other users clocked in.


• To login to a different display group, log out of Administrator mode and select which display group 
user mode will display.


F. Assigning Administrators & Managers
Administrators and Managers in Virtual TimeClock are users who are assigned permissions that allow 
them to access features like viewing reports and editing entries for other users. A Manager has limited 
access to settings and features, but an Administrator always has full access to everything.


Managers are assigned to a display group meaning that they can only view reports or edit entries for 
users that are members of the display group. A manager can be both a user and manager of a group. 
Assign a user to be a manager of a group by going to the Managers tab of the Display Groups window. 
Click Select and choose which users to give manager access to. To come back to this window later, go 
to Configure > Display Groups and select the Managers Tab.


Managers and Administrators can turn on administration mode from the File menu using their name and 
password. However, unlike an Administrator, Managers will only see the Display Group, reports and 
features that an Administrator has granted them access to.


To continue setup click Show All in toolbar. While in administration mode you can revisit this window by 
clicking the Configure gear icon in the toolbar on the In & Out Board. You can access TimeClock 
features directly through the menu bar while in Administration mode by clicking Configure. The 
different configuration categories are organized in the sections People, Groups, System, and Data.
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G. Breaks & Lunches
With the Configure window open, within the Groups Section select the Breaks & Lunches icon. You 
can track paid and unpaid breaks and lunches.	 


1. From the Configure Breaks & Lunches window select if breaks and lunches are paid, paid with a 
limit of time, or unpaid. 


2. Break and Lunch buttons are visible to users by default. The buttons can be removed by going to 
Configure > Display Groups and uncheck the boxes under the Breaks & Lunches section.


H. Activities
The time clock can track time spent on different tasks, jobs, or projects. To setup click the Configure 
program menu and choose Activities which is found in the Groups section. When users clock in they 
will select an activity. If you want to track time by projects or activities throughout the day instruct your 
employees to choose the correct activity when they clock in. Users can change activities as often as 
needed during a shift to track their time for tasks and billable projects. To learn more about activities, 
review the Overview of Activity Tracking Knowledge Base article on our website.
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1. Click the Add button to 
create a new activity. 


2. If you want users to be able 
to select the activity when 
clocking in then set the status 
to TimeClock and Manual 
Entries. 


3. Determine if activities are 
paid, unpaid or paid with a 
limit of time.


4. To assign activities to specific 

Restrict early or late 
return from lunch by 
setting shift rules in the 
Configure Shifts window.


Go to Configure > Auto 
Add/Deduct Time if you 
want to track lunch, but do 
not need to have 
employees clock out for 
lunch.	 	

You can view reports based on 
activities by clicking the Reports 
program menu and choose 
Activity Detail to get started.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/tracking-hours/activity-tracking-overview
http://www.redcort.com


I. Overtime Settings
To configure and assign overtime rules to users, select Overtime within the People section of the 
Configure window. To learn more about creating an overtime rule and how overtime hours are 
calculated, review the Overview of Overtime Knowledge Base article on our website.


J. Payroll Settings
Payroll Settings allows you to adjust the Payroll Frequency, Period, Timecard Approval, and Payroll 
Export. To configure, select Payroll Settings within the System section of the Configure window.

1. Set payroll frequency from the drop down menu.

2. Enter current payroll period start date. The system will autofill the end date by the payroll frequency 

selected, unless it is User Defined. 

3. If you plan on using 

payroll integration, ensure 
the TimeClock is 
compatible with your 
payroll company. Click 
here to find out if Virtual 
TimeClock imports into 
your program and follow 
the one-time setup guide 
for your payroll provider.


4. After setting up payroll 
integration with your 
provider, return to the 
Payroll Settings window. 
Select the company from 
the list and click Setup to 
complete the set up 
process.
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1. Select the built-in rule you want to 
edit and then click Modify Rule to set 
thresholds and rates.


2. Click Add to create a new Rule.


3. Assign an overtime rule to users in 
the main panel by clicking Edit and 
selecting the users to apply the rule.


Important Note: Users can 
only be assigned to one 

overtime rule.

http://www.redcort.com
https://www.redcort.com/virtual-timeclock-knowledge-base/features/overtime/overview-of-overtime
https://www.redcort.com/timeclock/timeclock-payroll-integration


K. Time Settings
To configure how hours are rounded and displayed on timecards select Time Settings within the 
System section of the Configure window


L. Security Rules
Password protecting administrative features will prevent employees from editing their own timecards 
and buddy punching. You can set security settings by selecting Security within the System section of 
the Configure window.


1. Requiring a password to turn on Administration is recommended for security and is enabled by 
default. If you do not want to require a password, click to uncheck the box labeled and click 
Apply.


2. Set and review password rules for users. Rules can be tightened or loosened based on your 
organization’s needs.


M. Schedule Backups
Backups are important because they enable you to restore lost data from unexpected events such as 
power or internet outages and hardware failures. To schedule a regular time clock database backup, 
select Backup Schedule within the Data section of the Configure window. Learn more about backups 
by reviewing our Overview of Backups Knowledge Base article.


1. Select desired backup schedule frequency. It is not required to backup Virtual TimeClock, but it is 
highly recommended. A manual backup can be performed in Administration mode from the In & 
Out board toolbar.


2. Choose backup folder and location. We recommend saving backups to a USB or Cloud service 
like Dropbox or OneDrive, so a computer crash does not wipe out all data.


• If a scheduled backup is chosen, the computer with the time clock much be on and the 
time clock running at the time of scheduled backup or the backup will not be completed. 


• Important Note: Do not store the backup on the same computer as the time clock. This 
does nothing to protect your data from disaster, computer theft or hard drive crash.
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1. Choose your timestamp source. If 
tampering with the computer’s 
clock is a concern, choose an 
Internet Time Server as the 
timestamp source.


2. Set your workweek start day. This 
does not affect your payroll period. 
It will affect how your weekly totals 
are displayed on reports.


3. Select the time rounding setting. 
This is based on how hour totals 
will be displayed. This will not 
change the recorded start and stop 
times, only how the hours are 
calculated. Find out more.

Time Rounding: With quarter hour rounding, 8:07 rounds down to 8:00 
and 8:08 rounds up to 8:15.

http://www.redcort.com
https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/timestamp-source
https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/time-rounding
https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/timestamp-source
https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/time-rounding
https://www.redcort.com/virtual-timeclock-knowledge-base/features/passwords-and-security/overview-passwords-security
https://www.redcort.com/virtual-timeclock-knowledge-base/features/backups/backups-overview


N. Licensing
After you purchase a license from Redcort Software, an email containing the license key will be sent to 
you. To activate it go to Help, then License Key. The software will continue to run in eval mode until a 
valid license key is entered. Click to learn more about Virtual TimeClock free trials.


O. Administration and User Mode
There are two modes of the time clock. One is Administration Mode, which you must be in to make 
changes to settings and where Managers and Administrators can edit entries and access reports. To 
turn Administration Mode on and off, go to File then Turn Administration On/Off. You will be 
prompted to enter your administrator or manager password.

If you are logged into Administration Mode, the 
toolbar of icons and functions are visible as well 
as the Configure settings. TimeClock functions 
can be accessed directly from the program menu 
by clicking the Configure menu bar or select the 
Configure icon in the Administrative toolbar. 
Below is what the TimeClock looks like in 
Administration Mode.


Congratulations! Virtual TimeClock Pro is now setup and ready to use!


Copyright 1986-2023 Redcort Software Inc. All Rights Reserved. Virtual TimeClock and Virtual TimeClock Pro are registered trademarks of Redcort 
Software Inc. All other names mentioned are trademarks or registered trademarks of their respective holders in the United States and other countries.
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Always Turn Administration Off 
before leaving the computer 
unattended and allowing users to 
clock in/out.

Need more help with the topics covered in this guide? 
Check out the Administrator Quick Reference found in the Help menu for 
details on all program functions. 

Need to show employees how to use the time clock? 
Print the User Quick Reference from the Help menu.

User Mode: In & Out Board User Mode - PIN Interface


https://www.redcort.com/files/pdfs/vtc-pro-docs/Virtual-TimeClock-Pro-Users-Guide-Windows.pdf
https://www.redcort.com/timeclock/free-timeclock-software-trial
http://www.redcort.com
https://www.redcort.com/files/pdfs/vtc-pro-docs/Virtual-TimeClock-Pro-Users-Guide-Windows.pdf

